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1. Installation of the NCP Exclusive Remote Access Management Server 

1.1. Prerequisites 

Before installing the NCP Exclusive Remote Access Management Server (in the following referred to as 
Management Server) you have to prepare an empty database with an according ODBC configuration. Please 
refer to the appendix A - Installation of supported database servers for details. 
 
The scenario used for this documentation is a very simplified one. Underneath you see the systems involved 
including IP addresses used in this environment. 

 
 
The following files are required for installation of the NCP Exclusive Remote Management solution (where 
“xxxxx” is the revision number of the released version which was not available while creating this document):  
 Installation package for the Management Server 

NCP-Exclusive-Management_Windows_x86-64_500_xxxxx.exe 
 Installation package for NCP Secure Management Console 

NCP-Management-Console_Windows_x86_500_xxxxx.exe 
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1.2. Installation of the Management Server on Windows 

Open File Explorer and select the folder containing the Management Server installation package. 
 Execute the installer package NCP-Exclusive-Management_Windows_x86-64_500_38190.exe 

 

 
Select the preferred installation language and click next to start the “InstallShield Wizard” 

   
 

 Accept the “License Agreement” and select the “Destination Folder” 
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 Confirm to start the installation by clicking “Install” and the Management Server software will be installed 

  
 

Once the software has been installed the NCP Management Server – Configuration will be started. It will come 
up with options for an ODBC based database connection which is not used in this sample setup. Therefore, 
press OK in the message box shown below and also close (or cancel) the ODBC Data Source Administrator (64-
bit) dialog. 

  
 
In the tab Database Connection of the NCP Management Server – Configuration 
 As DB Interface select MariaDB Connector 
 Enter Username and Password of the database administrator 
 Enter the Hostname or IP address of your database server (here: localhost or 127.0.0.1) 
 The standard Port for this setup is 3306 
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 From the Database list select the previously created one (here: ncp_excl_mgm) 

 
 Click “Apply” 
 Click “Test” to verify a working connection 

You should get 'Database connection established!' 

  
 Press “OK” to finish the installation 

 
The installation of the Management Server is completed now. Press “Finish” in the “InstallShield Wizard”. 

 
 

  



 

 

Americas: NCP engineering, Inc. · 444 Castro Street, Suite 711 · Mountain View, CA 94041 · Phone: +1 (650) 316-6273 · www.ncp-e.com 

Next Generation Network Access Technology 

Page 9 / 72 Americas: NCP engineering, Inc. · 678 Georgia Ave. · Sunnyvale, CA 94085 · Phone: +1 (650) 316-6273 · www.ncp-e.com  

Others: NCP engineering GmbH · Dombuehler Str. 2 · 90449 Nuremberg · Germany · Fon +49 911 9968-0 · Fax +49 911 9968-299 

Installation and Config Guide 
NCP Exclusive Remote Access Solution for Juniper SRX Gateways 
1.3. Installation of the Management Server on Linux  

1.3.1. Preparation of CentOS 

This document describes how to install the NCP Exclusive Enterprise Management Server on CentOS 7 Linux. 
You need to provide a basic installation of CentOS 7 with the necessary routing and access settings required for 
your specific environment. The installation of the NCP Exclusive Remote Access Management Server requires 
root privileges. If you want to use an individual user, add the account to the sudoers. 

1.3.2. Installation of the Management Server 

Copy the NCP Exclusive Remote Access Management installation package to the Linux system and apply 
execute properties. For this document version 5.0 revision 38209 was used. However, the description provided 
below will apply for later versions as well. 
Execute the binary installer ncp-exclusive-management_linux_x86-64_500_38209.bin and follow the instructions 
displayed in the console. The Management Server will be installed automatically with a 30-day trial license 
without functional limitations and a maximum of 100 managed units. 
Below you see an excerpt of the installation routine: 
 
[root@centos tmp]# ./ncp-exclusive-management_linux_x86-64_500_38209.bin 
                   ------------------------------------------ 
                   > NCP Exclusive Remote Access Management < 
                   ------------------------------------------ 
 
Verifying contained installation data... succeeded 
Unpacking installation data... succeeded 
 
=== Calling installation routine === 
 
Checking compatibility... succeeded 
 
No previous installation of this product was found. 
 
You are about to install the following product version: 
 
        Product code name: sem 
        Product full name: NCP Exclusive Remote Access Management 
        Product version: 5.00 
        OEM variant: junipersrx 
        Target architecture: x86_64 
        Target OS: linux 
        Library type: shared 
        Build type: release-speed 
        Build label: trunk 
        Build revision: rev38209 
        Build date: Wed 20 Dec 2017 01:40:16 PM CET 
 
Do you want to perform this installation? 
 
        (yes/y/no/n): y 
 
. 
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. 
. 
 
Installing 
data...............................................................................................................
...................................................................................................................
............... succeeded 
 
NCP Exclusive Remote Access Management has been successfully configured to start on boot. 
 
NCP Exclusive Remote Access Management can be started by using the command 
 
        /usr/bin/systemctl start ncp-sem.service 
 
and stopped by using the command 
 
        /usr/bin/systemctl stop ncp-sem.service 
 

 
After the installation the Management Server cannot yet be started due to the database configuration still 
missing. 

1.3.3. Configuration of the Management Server for MariaDB with Connector/C 

Edit the DB section in the Management Server's configuration file /opt/ncp/sem/ncprsu.conf as shown 
below: 
[DB] 
DriverType       = mysql 
DBUserName       = mydbadmin 
DBPassword       = mypassword 
Host             = 127.0.0.1  
Port             = 3306 
Database         = mydatabase 
LibraryFileName  = /usr/lib64/mysql/libmysqlclient.so.18 

1.3.4. Launching the Management Server 

Now the Management Server has to be started which can be done with a reboot or by executing the command 
stated below: 
sudo systemctl start ncp-sem.service 

 
A CentOS default installation will automatically have the firewall enabled denying most incoming 
communication to the system also blocking the Management Console to connect.  The easiest way to get 
around this is to disable the firewall on CentOS, as described below. Please make sure to follow your internal 
security policies whether this is a valid approach for your environment! 
sudo systemctl disable firewalld 
sudo systemctl stop firewalld 

 
Now you can use the Management Console to work with the Management Server.  
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2. Management Console and plug-ins 

2.1. Installation of the Management Console 

Open File Explorer and select the folder containing the Management Server installation package. 
 Execute the installer package NCP-Management-Console_Windows_x86_500_38190.exe 

 
 

 Select the preferred installation language and Click next to start the “InstallShield Wizard” 

  
 Accept the “License Agreement” and select the “Destination Folder” 
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 Confirm to start the installation by clicking “Install” 

  
 

 The installation of the Management Console is completed now. Press “Finish” in the “InstallShield Wizard”. 
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2.2. Installation of the Management Server plug-ins 

Use the built-in Administrator account (without password) to connect to the Management Server for the first 
time. You must initially accept (permit) the default certificate presented by the Management Server securing 
the TLS connection. After that you will be prompted to define the Password for the Administrator. 
 

       
 

 
 
With the first Administrator logon to the Management Server you have to enable the plug-ins you want to use. 
In this example all available plug-ins are checked to be installed. 

 



 

 

Americas: NCP engineering, Inc. · 444 Castro Street, Suite 711 · Mountain View, CA 94041 · Phone: +1 (650) 316-6273 · www.ncp-e.com 

Next Generation Network Access Technology 

Page 14 / 72 Americas: NCP engineering, Inc. · 678 Georgia Ave. · Sunnyvale, CA 94085 · Phone: +1 (650) 316-6273 · www.ncp-e.com  

Others: NCP engineering GmbH · Dombuehler Str. 2 · 90449 Nuremberg · Germany · Fon +49 911 9968-0 · Fax +49 911 9968-299 

Installation and Config Guide 
NCP Exclusive Remote Access Solution for Juniper SRX Gateways 
 
After the initial setup is done the Management Console will open as shown below. 
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2.3. Creating a new administrator 

We recommend to immediately create personalized administrator account for the respective users who are 
going to have administrative access to the Management Server. Administrator privileges are assigned through 
administrator groups which contain the levels of access. Therefore, it is also a recommendation to create a new 
administrator group (here: Full Admin) as a copy of the built-in “System Administrator” group. 
 

2.3.1. Creating a new administrator group 

 From the “Edit” menu select “Administrator groups” and select “System Administrator” from the list and 
click Copy. 

  
 

 In the following dialogue you can enter “Name” and “Description” for the new administrator group. Leave 
everything else untouched. Then go to the “Info” tab and tick the option “Entry inherited to subgroups”. 
This will make sure that the new administrator group is also available in any subgroup. Click “OK”. 
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 The new group will be listed as shown below. 

 
Close the dialogue and then proceed with enabling the previously activated plug-ins for the new group. 
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2.3.2. Enabling plug-ins for the new administrator group 

For any new administrator group, the plug-ins have to be enabled separately. 
 Select “Console Plug-ins” from the “Management Server” menu 

 
 

 Enable the required plug-ins for the “Full Admin” group and after having done so re-login with the 
Management Console to the Management Server. 
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2.3.3. Creating a new administrator 

With the administrator group in place the new administrator account can now be created. 
 From the “Edit” menu select “Administrators”, then click “New” to create a new individual admin account. 

Enter “Name” and “Displayed as” and click “Next”. 

  
 

 Specify a password for the new account. If nothing is entered the administrator will be prompted for 
defining a password during first login. Click “Next” and then assign the previously created “Administrator 
group” to the new administrator. Click “Next” 
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 Click “Next” and the new entry will be stored and listed in the Administrators overview: 

 
 
Instead of working with the rather anonymous built-in “Administrator” all admins should always work with 
their personal account to make sure that changes are bound to the according people. The “Administrator” 
overview can be closed now. 
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3. Configuration of the Management Server 

This description will help you set up the Management Server in a way that will be ideal for testing purposes or 
proof-of-concept. Therefore, some values will be modified especially to achieve quick feedback while testing. 
When these kinds of changes are suggested there will be a comment hinting for better settings in a productive 
setup. 
The goal is to create an environment which not only handles the configurations and licenses of NCP Exclusive 
Remote Access Clients but also provides a RADIUS server for your Juniper SRX system allowing for EAP 
authentication using EAP-MD5 and EAP-TLS. 
Let’s get started… 
 
Start the Management Console and logon to the Management Server with your own administrator account. 
The console will look open this: 
 

 
 

3.1. Group structure 

The Management Server lets you create a group structure which most of the time follows the structure already 
used within your Microsoft Active Directory (or maybe following the department structure in your 
organization). This sample configuration will have groups created according to the method of authentication of 
the clients configured within each group. As we are going to work with EAP-MD5 and EAP-TLS, as mentioned 
above, we will create two groups named exactly like this. 
To create a new group move the mouse to the folder of the root group in the top left part of Management 
Console and perform a right mouse click which will open a context menu. Here select “New” as shown below: 
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Enter the “Name” of the new group (here: EAP-MD5”) and an optional “Description”. Click “OK” to confirm. The 
new group will appear in the group tree under root. Create a second group with name “EAP-TLS” the same way 
you added the one above. Your group tree should look like this now: 
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3.2. Configuring the Management Server’s integrated RADIUS server 

The Management Server comes with an integrated RADIUS server supporting EAP-MD5 and EAP-TLS among 
others. Therefore, it can be used in a scenario where the Juniper SRX acts as an EAP proxy to authenticate 
remote access VPN users. In this test scenario these two authentication methods will be used. 

3.2.1. Adding a RADIUS configuration for the Juniper SRX 

This setup will only work with username and password within the RADIUS configuration of the Management 
Server for the Juniper SRX RADIUS client. No special dictionaries or attribute value pair configuration is required 
for this scenario and just a minimal configuration must be created in the Management Server. 
Make sure to be on the root group and select “Configuration” from the “RADIUS” menu. 

 
Leave the “NCP Secure Server” entry untouched and click new to create a fresh “RADIUS configuration”. 

 
Just enter a meaningful “Name” (here: SRX) for your Juniper SRX system, then click “OK” to save the changes. 
No further settings are required here. 
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3.2.2. Adding the Juniper SRX as RADIUS client 

To permit RADIUS requests from the SRX to the Management Server RADIUS server the SRX must be added as 
RADIUS client. From the “RADIUS” menu select “Clients” and click “New”. 

 
 
Enter a meaninful “Name” for your SRX and its “IP address” as well the “Shared secret” which must also be 
configured in your SRX system for this RADIUS server. In the Juniper SRX configuration the related settings are: 
access profile [SRX aaa access-profile name] radius-server 10.10.10.250 port 1812 
access profile [SRX aaa access-profile name] radius-server 10.10.10.250 secret "mysharedsecret" 

Finally select the previously created “SRX” entry as “RADIUS configuration” then click “OK” to save the changes. 
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3.2.3. Defining EAP authentication for Management Server groups 

To conclude the RADIUS server configuration, we need to let the Management Server know for which group we 
would like to have EAP-MD5 and for which EAP-TLS as authentication method. As our groups have been named 
accordingly it is easy to see which group should have which method, but how is this achieved? 
 
Let’s start with EAP-MD5 for the group EAP-MD5 and select the group in Management Console. Then go to 
“Group Settings” in the “RADIUS” menu. 

 
Enable the option “Allow EAP-MD5” to activate this authentication method for the group. Disable all other 
options as they are not required. 
 
The same needs to be done for the EAP-TLS group only that “Allow EAP-TLS” must be enabled here. 
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3.3. Configuring the Exclusive Remote Access Client in Management Server 

3.3.1. Creating a configuration template for Exclusive Remote Access Client 

The next step is to create a configuration template for the Exclusive Remote Access Client which will eventually 
be used to connect the client to the SRX. 
Select the root group in Management Console’s group tree and then open the “Client Configuration” node in 
the plug-in section and select “Client Templates”. 
Insert a client template by clicking on the new entry symbol in the icon bar of the Management Console. The 
options for a new client template will be open as displayed in the following screenshots. 
 

  
 

 
 
Change the name of the new “Template” to “SRX – IKEv2 with EAP” and change the “Product type” to “NCP 
Exclusive Remote Access Client”. In the “Info” tab check the option “Entry inherited by subgroups” and save the 
altered settings by clicking the green tick in icon bar of the Management Console. 
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These settings will provide all configuration options for the Exclusive Remote Access Client and will make this 
template available not only within the root group but also all subgroups. Would you intend to create a template 
only available in one specific group, you will create this template in that group and not enable the option to 
inherit it by subgroups. 
At this stage we will not yet modify any other of the configuration options here, this will come later on. 
 

Configuration of the connection profile to connect to the SRX 

Open the template node “SRX – IKEv2 with EAP” and whole set of sub-nodes will appear: 
 Profiles 

The profiles specify which configuration parameters to use in order to connect to the SRX 
 IKE Policies 

Definition of proposals for IKE version 1 
 IKEv2 Policies 

Definition of proposals for IKE version 2 
 IPSec Policies 

Definition of proposals for ESP 
 Wi-Fi Profiles 

Definition of connections parameters to connect to wireless access points using the clients built-in Wi-Fi 
management 

 Certificate Configuration 
Definition of the certificate configuration to use when certificate based authentication is to be used 

 VPN bypass 
Special option to allow specific application to communicate outside the VPN tunnel 

 
Within this scenario we will only work with “Profiles” and “Certificate Configuration” (the latter when 
configuring EAP-TLS). The other options will be untouched in this documentation. 
Create a new profile by selecting “Profiles” and perform a right mouse click. This will open a context menu 
where you can left-click on “New entry”. 
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We try to stick with the “Configuration” tab for now and specify the settings to eventually be able to properly 
connect to the SRX. The groups “Split Tunneling” and “VPN Bypass” will not be touched in this document as 
they are not required for the sample scenario. 
Group “Standard Configuration” 

 
 “Profile Name” 

Enter a meaningful name as this will appear in client GUI and the user will maybe have to choose between 
different profiles to connect to different SRX systems or within different environments. 
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 “Tunnel Endpoint” 

This is either the IP address or hostname of the SRX to establish the connection to. Usually this will be an 
official address which can be access over the internet. 

 “VPN Path Finder” 
Enable this option as it will guarantee to be able to establish the VPN tunnel even when the specific IPsec 
VPN ports are blocked by a firewall. 

Group “IPsec” 

 
Stick with the default values here only that the “IKE ID” has to be user specific. To do so switch to the “User 
parameters” tab and check the box for “IKE ID”. This will let us specify the IKE ID on a per user basis. 
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Group “Server Parameters” 

 
Just check the box for “Create configuration on RADIUS server”. This will automatically create an entry in the 
Management Server’s internal RADIUS server whenever a new user is created using this template.  
 
Save the changes by clicking on the green tick in the icon bar. 
 

3.3.2. Creating a new user in the Management Server 

To create a configuration for Exclusive Remote Access Client we need to create a new client entry in the 
Management Server. Select the group “EAP-MD5” and then “Clients” in the “Client Configuration” plug-in. 

 

 
After clicking “Finish” the just created “Client” configuration will be displayed in the Management Console 
window. 
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As configured earlier the “IKE ID” parameter is set on a per user basis and so the according value has to be 
entered individually. Open the node of the user (here: user1@eap.md5) and the “Profiles”. Then select the 
previously defined profile (here: My SRX profile) and in the “Configuration” tab select the “IPsec” group. 
Underneath “IPsec” within the “IKEv2” settings, enter the username (here: user1@eap.md5) for the “IKE ID”. 

 
Save your changes with the green tick in the icon bar. 
 
Note: The IKE ID can be the same for all users or be used to differentiate between user groups. Individual user 
authentication happens separately in EAP with the RADIUS server. For more information, please consult the 
IKEv2 related documentation of your Juniper SRX. 
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Select the “Info” tab to see the current status of the client configuration: 

 
In the “Profile settings” section you can see that configuration has already been “changed” but neither has it 
been “created” nor “loaded”. The “last action” is “Changed”. This means that no RADIUS entry has yet been 
created nor is the configuration available for download from the Management Server. This would be indicated 
by a time stamp in “created”. Had a client already downloaded the configuration there would also be time 
stamp in “loaded”. 
 
Before moving on with creating the RADIUS entries for our new user first take a look at the “Profile” 
configuration. To do so click on “My SRX profile” (or whatever may be the name of the profile you defined 
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previously) in the “Profiles” node on the left hand side.

 
The display will show the values that you entered while having been walked through the new-client-wizard 
before. 

3.3.3. Creating the RADIUS entries for the new client 

Select the new client entry on the left side of the Management Console and perform a right mouse click to 
open the context menu. There click on “Create Client Configuration” and in the following dialogue confirm to 
create “Current user’s configuration” with “OK”. 

 
 
The status change for the configuration can be viewed in the “Info” tab of the client where the “Profile 
Settings” should similar to the one shown below: 
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However, it is wise to enable the live log viewer showing various information at bottom of the Management 
Console. Select “Log view” from the “View” menu where the live log can be enabled. Check the boxes for 
“Show log entries” and “Security” (here colored red), “RADIUS” (here colored green), “Tasks” (here colored 
black). 

 
Then click “OK” to see the log information at the bottom of the console. 

 
The latest entries are listed on top of the live log. You should see entries for the creation of the client 
configuration and license distribution. The important one right now is: 
Creating Client Configurations completed (1 created, 0 with error) (Task x) 

The significant part is “0 with error” which indicates that the RADIUS entries were successfully written. 
With this the Management Server side is good to go. Now we need to take care of the client. 
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4. Installing and Configuring the Exclusive Remote Access Client 

This chapter describes how the NCP Exclusive Remote Access Client is set up on the user’s system. 
Please refer to B Client Installation on Windows for detailed instructions. 
After successful installation the client has to be configured to establish a VPN connection to the Juniper SRX 
gateway. There are two ways to do so: 
 Creating the configuration directly in the client 

Matching all the settings already taken care of in the Management Server’s client configuration. 
 Copying the configuration previously created on the Management Server 

Saving the configuration with the Management Console and copying it over to the client system. 
 

4.1. Creating a new client configuration 

To create the configuration directly in the client the “Exclusive Remote Access Client Monitor” has to be started 
if not yet open. From the “Configuration” menu select “Profiles” and click “Add” to create a new entry. 

  
 
The “New Profile Wizard” will prompt for the input of the “Profile name” (here: “My Local SRX profile”). Use a 
different name than already defined in the Management Server before as we will retrieve the configuration 
from the Management Server at a later stage and having different names is the easiest way to immediately 
determine when the config changed.  

  
Click “Next” to define the “Communication Medium” in the following dialogue. As nothing needs to be changed 
here, click “Next”.  
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In “VPN Gateway Parameters” enter the IP address or hostname for the VPN gateway’s tunnel endpoint. With 
“Next” you get to the “Certificate Usage”. As no certificate is used on client side when working with EAP-MD5 
select “No Certificate for Authentication” and click “Next”. 

  
 
After that provide “VPN User ID” and “VPN Password” which will be used for the EAP-MD5 authentication with 
the RADIUS server. Enter the same username and password as entered previously in the Management Server 
configuration. Then click “Next” to provide the “IKE ID” which is also the one you previously entered in the 
Management Server part. 

  
Click “Finish” to end the profile wizard. 
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This concludes the profile configuration of the client. It will work with default IKEv2 and IPsec proposals which 
have to be configured accordingly on the SRX. These defaults are: 
 IKEv2 policy 

 Encryption: AES-GCM 256 bit 
 Pseudo-Random-Function: HMAC SHA2 384 bit 
 IKE Diffie Hellman group: DH 19 (prime256v1) 

 IPsec policy 
 Protocol: ESP 
 Encryption: AES-GCM 256 bit 
 PFS group: DH 19 (prime256v1) 

These proposals have to be configured accordingly on the Juniper SRX gateway to accept the proposals. 
Before starting to test the VPN connection the client must be prepared to be able to accept the certificate of 
the SRX which will always be presented within the IKEv2 negotiation when using EAP as authentication method. 
Therefore, the issuer certificate must be placed in the “CaCerts” folder in the client’s installation path. 

 
 
You can verify that issuer has been accepted by the client by selecting “Display CA Certificates” under 
“Certificates” in the “Connection” menu of client’s GUI. 

 
 
As long the everything is set on the Juniper SRX gateway the Exclusive Remote Access Client is now good to go. 
Please refer to the Quick Configuration Guides provided on the NCP web site for detailed settings: 
https://www.ncp-e.com/en/exclusive-remote-access-solution/documents-faq/ 

  

https://www.ncp-e.com/en/exclusive-remote-access-solution/documents-faq/
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4.1.1. Testing the local client configuration 

Click “Connect” to establish the VPN connection to the Juniper SRX. 
  

 
 
The live log of the Management Console will show an accepted RADIUS request using EAP: 

 
 

The client’s log file shows the negotiation steps in detail. Select “Logbook..” from the “Help” menu to take a 
closer look. Below is just an excerpt of most significant lines. 
 

Initiation of the VPN connection. The first line shows the start of the IPsec negotiation. The second line 
indicates which networking interface of the client system is used to send the first message out. Following this 
the client sends (XMIT) the initial INIT message to SRX (vpngw=[IP address] and reveives the response which is 
recognized as coming from a Juniper SRX gateway. 

  
 

A few log lines later first AUTH messeage is sent (XMIT) to the SRX followed by additional info regarding the 
client’s IKE ID. 

 
 

A little bit further down the log the client initiates the EAP negotiation and the confirmation that the client 
received the SRX’ certificate and that it is authenticating using RSA. A few lines down the IKE ID of SRX is also 
shown in the log. 

 
 

3/30/2017 3:34:13 PM - IPSec: Start building connection 
3/30/2017 3:34:13 PM - ipsdial: internal connect chose the following interface address=192.168.100.10 
3/30/2017 3:34:13 PM - Ike: ConRef=4, XMIT_MSG1_INIT, name=My local SRX profile, vpngw=192.168.100.249:500 
3/30/2017 3:34:13 PM - Ike: ConRef=4,  RECV_MSG2_INIT, name=My local SRX profile, vpngw=192.168.100.249:500 
3/30/2017 3:34:13 PM - Ike: ConRef=4, Remote peer is a JUNIPER-SRX 

3/30/2017 3:34:13 PM - Ike: ConRef=4, XMIT_MSG1_AUTH, name=My local SRX profile, vpngw=192.168.100.249:500 
3/30/2017 3:34:13 PM - Ikev2:send idi payload:ID_USER_FQDN:pid=0,port=0,user1@eap.md5 

3/30/2017 3:34:13 PM - IkeV2: ConRef=4,Auth - initiating an EAP session 
3/30/2017 3:34:14 PM - Ikev2: ConRef=4, Received 1 certificates. 
3/30/2017 3:34:14 PM - Auth: ConRef=4,Remote is authenticating with=1,RSA 
… 
3/30/2017 3:34:14 PM - Ikev2:recv IDR payload:ID_FQDN:pid=0,port=0,vsrx.vm-ncp.local 
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The log also shows information about the EAP negotiation indicating that MD5 is used here: 

 
 

When everything works out fine the log will show information about assigned IP addresses and state the VPN 
tunnel was established successfully. The first success line listed below indicates that all the IPsec (ESP) phase 
was successful while the last line in the below informs that the assigned IP address was successfully bound to 
client’s NIC and therefore the link is operational. 

 
 

4.2. Copying the configuration previously created on the Management Server 

As we now know that the Management Server configuration regarding the RADIUS EAP authentication works 
we look into the second option mentioned earlier in this chapter to configure the client. This will be by saving 
the configuration created previously in the Management Server to file and copying it over to the client. 

4.2.1. Save the Management Server based client configuration to file 

 Start the Management Console and logon to the Management Server. 
 Select the “EAP-MD5” in the group section. 
 Click on “Clients” in the “Client Configuration” plug-in 
 Right click on the user object to open the context menu. 
 Select “Copy Client Configuration to hard disk” and save the “ncpphone.cnf” file. 

 

  
 

3/30/2017 3:34:14 PM - Eap-Md5Cp:Client Receiving MD5-Challenge 
3/30/2017 3:34:14 PM - EAP:Sending MD5Response - user1@eap.md5 
3/30/2017 3:34:14 PM - Eap: status=0,Method=MD5 
3/30/2017 3:34:14 PM - Eap: status success,method=MD5 

3/30/2017 3:34:14 PM - IPSec: Assigned IP Address:IPv4=172.16.119.13,IPv6=0.0.0.0 
3/30/2017 3:34:14 PM - SUCCESS: IpSec connection ready 
3/30/2017 3:34:17 PM - SUCCESS: Link -> <My local SRX profile> IP address assigned to IP stack - link is operational. 
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The NCP Exclusive Remote Access Clients processes two major configuration file formats: 
 ncpphone.cfg  

This is the general configuration file written locally by the client. Whenever you locally change a setting the 
“ncpphone.cfg” file will be updated and stored. 

 ncpphone.cnf 
This is the configuration file format created by the Management Server. In addition to the data provided by 
the “ncpphone.cfg” it can also contain information regarding installation and some other things. It is used to 
import configuration data into a “ncpphone.cfg”. 

4.2.2. Configuring the client using the “ncpphone.cnf” file 

Copy the “ncpphone.cnf” file into the client’s installation folder (“%programfiles%\NCP\Exclusive Remote 
Access Client\”). Mind that you must have administrator privileges to copy the file! 
There will be several “ncpphone” files with different extensions in the client installation folder now. The “.bak” 
and “.sav” are internal backup files created by the client automatically and we don’t need care for those. 
 
As mentioned before the “ncpphone.cnf” is used as source to import information into an existing 
“ncpphone.cfg” file. The import can manually be triggered by monitor application starting up. Therefore, just 
exit the “NCP Exclusive Remote Access Client Monitor” (menu “Connection”; select “Exit”) and open it again. 
At first glance you won’t notice any change looking at the client monitor. However, when pulling down the list 
of “Connection profiles you will see two entries where there was only one before: 
 

  
 
In the example above the profile previously created in the client was named “My local SRX profile”. The second 
profile “My SRX profile” imported from the “ncpphone.cnf” file was created with Management Console before. 
It should work as well as to connect with the SRX as locally configured one. 
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4.2.3. Testing the Management Server originating client configuration 

Select the profile created on the Management Server (here: “My SRX profile”) and click “Connect”. 
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5. Enabling communication between client and Management Server 

This far it was only about connecting the VPN tunnel between client and SRX without any verification of data 
transfer through the tunnel. The NCP Exclusive Remote Access Client must be able to communicate with its 
Management Server. This is for two reasons, where the first one is licensing and second one central 
management of the client. The goal of this chapter is to describe how to configure client and Management 
Server to make this happen. 

5.1. Basic network communication through the VPN tunnel 

For ideal testing purposes make sure that you can “ping” the Management Server and that the traffic is not 
(yet) selectively blocked on port and protocol level. The Management Server must be accessible through the 
VPN tunnel. 
Establish the VPN connection between client and SRX. Then open a command prompt on the client system and 
ping the IP address of the Management Server (here: 10.10.10.1). The result should be like this: 
 
C:\>ping 10.10.10.1 
 
Pinging 10.10.10.1 with 32 bytes of data: 
Reply from 10.10.10.1: bytes=32 time=1ms TTL=126 
Reply from 10.10.10.1: bytes=32 time<1ms TTL=126 
Reply from 10.10.10.1: bytes=32 time<1ms TTL=126 
Reply from 10.10.10.1: bytes=32 time<1ms TTL=126 
 
Ping statistics for 10.10.10.1: 
    Packets: Sent = 4, Received = 4, Lost = 0 (0% loss), 
Approximate round trip times in milli-seconds: 
    Minimum = 0ms, Maximum = 1ms, Average = 0ms 
C:\> 

 
If you cannot ping the Management Server you have to check the network/firewall settings of your test 
environment until the Management Server can be reached through the tunnel. In this setup the client is 
assigned an IP address on the network 172.16.119.0, so the Management Server will have to have a route to 
the SRX for this network. 

5.2. Enabling the client to reach out for the Management Server 

The part of the client responsible for communication with the Management Server is the “NCP Client Update 
Service” running in the background (short: “update client”). The update client needs to know the IP address of 
the Management Server and will start reaching out for the Management Server shortly after the VPN link is 
operational. It will try 5 times with a retry timer of 15 seconds. If there is no response from the Management 
Server the update client will go to sleep for 1 hour (3600 seconds) and then try again. 
  



 

 

Americas: NCP engineering, Inc. · 444 Castro Street, Suite 711 · Mountain View, CA 94041 · Phone: +1 (650) 316-6273 · www.ncp-e.com 

Next Generation Network Access Technology 

Page 42 / 72 Americas: NCP engineering, Inc. · 678 Georgia Ave. · Sunnyvale, CA 94085 · Phone: +1 (650) 316-6273 · www.ncp-e.com  

Others: NCP engineering GmbH · Dombuehler Str. 2 · 90449 Nuremberg · Germany · Fon +49 911 9968-0 · Fax +49 911 9968-299 

Installation and Config Guide 
NCP Exclusive Remote Access Solution for Juniper SRX Gateways 
Configure the IP address of your Management Server directly in the locally created client profile “My local SRX 
profile”. To do so select “Profiles” from the “Configuration” menu and click “Edit”. 

  
 
Go to the “Connection” configuration group and in “DNS / Management” enter the IP address of your 
Management Server in “1. Management Server” (here: 10.10.10.1). Then click “OK” to confirm the changes and 
“OK” to close the “Profiles” dialogue. 

 
 
The following pages will describe the communication between update client and Management Server step by 
step. Therefore, it is best to also take look at the log of the client as it shows what is happening behind the 
scenes. Open the client’s log view by selecting “Logbook…” from the “Help” menu and in the “Log Book” 
window click on the link “Show search (Ctrl-F)” just above the “Close” button. 
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New options for log view will appear at the top of the window. Enter “update” in the “Filter” field and click on 
the “Filter” icon right next to the field. 

 
 
This will only show log lines containing the string “update” and so only log entries related to the update process 
will be displayed while this filter is applied. As the configuration to reach out for the Management Server has 
already been added the update client should start to send requests to the Management Server as soon as the 
VPN tunnel is up. 
So press “Connect” in the client monitor and wait for the connection to be established and the update client 
starting to send messages. 

 
 
As shown in the previous screenshot you should see log entries of a successful connection of the update client 
to the Management Server and the information that the “Software is the current release”. The update client 
will try again in 86400 seconds which is 24 hours. 
With this result the client part is ready to go with the Management Server. However, there need to be some 
adjustments on the Management Server which are going to be dealt with subsequently. 
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5.3. Configuring the Management Server to provide updates for clients 

There are several things that need clarification before starting with further configuration of the Management 
Server. These are: 
 How does the update client connect to the Management Server? 

Is there authentication in place and what protocol and ports are used? 
 How can the update intervals be modified? 

It is not very useful to wait 24 hours for the next update attempt of the client, especially not in a test 
environment. 

 What is the criteria for the update client to state that the “Software is the current release”? 
What kind of updates can be provided by the Management Server and how? 

5.3.1. Connection parameters of the update 

The connection of the update client to the Management Server is TCP based and there is the update method 
over VPN which is described here and over LAN which can be used independently of the VPN tunnel but is not 
part of this document. When connecting over VPN the update client sends its messages over TCP port 12501 to 
the Management Server (see the communication overview in the appendix for detailed information about the 
protocols and ports used). So any firewall between the SRX gateway and the Management Server is required to 
permit TCP port 12501 from the VPN clients’ address range to the Management Server. 
When the update client is able to access the Management Server it will present two possible usernames (called 
the “Remote Software Update ID” or short: “RSUID” to the management server. These to RSUIDs are: 
 Hostname 
 VPN username 
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The Management Server will always first look for an entry with the hostname in all the Management Server’s 
user database; if no entry is found then will it look for an entry matching the VPN username. In our sample 
configuration we defined the VPN username to be used as RSUID and when the user “user1@eap.md5” was 
created before the entry was saved accordingly. This can be looked up with the Management Console in the 
“Configuration” tab within the “General” group as highlighted in the previous screenshot. 
With the first connection of the update client over VPN each client and the Management Server will negotiate a 
random shared secret, saved on both sides, which has to presented by the update client for future connections. 
Look in “Info” tab to see the status of the ”RSU secret”. 

 
 
You can “Reset” the “RSU secret” should you require to do so, for example if the client system is fully reset and 
the client won’t hold the previously negotiated information anymore. A reset “RSU secret” will be negotiated 
again with the first contact over VPN. 
 
The live log of the Management Console will also show helpful information for every update client connection 
to the Management Server. This has to be enabled in “View” menu selecting “Log view” as we already did 
before for “Security”, “RADIUS” and “Tasks”. Enable “RSU Login” to show update sessions related information 
then press “OK”. 
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The log view will immediately show entries of recent update client activity: 

 
 
The top line stating that a client contacted the Management Server with RSUID “user1@eap.md5” and the 
hostname of the system the client is installed on (here: “DESKTOP-JO4AL9J”). Whenever a update client 
connects to the Management Server a log line like this will be displayed. 

5.3.2. Modifying the update interval 

Working in a test environment or setting up a PoC one will want the update clients to look for configurations 
much more frequently than in an eventual productive environment. When started (usually after the system has 
started up) the update client will wait for the VPN connection and then contact the Management Server. Within 
this session the update client will be informed at what intervals it shall re-connect asking for updates. As 
already mentioned previously the default value for this is 86400 seconds (24 hours). It would be quite 
inconvenient to wait that long to receive an update after changes. You could also stop and restart the “rwsrsu” 
service to force the update client to forget the timer but this also is not the most convenient approach. While 
testing or still setting up the environment just decrease the interval to 15 or 30 seconds instead. To do so call 
“Settings” from the “Management Server” menu and scroll down to the “Group” “Clients”, “Edit” the “Value” 
for the “CheckInterval” and change it to “15” seconds. Press “OK” to confirm the change and “Close” the 
settings window again. The modification will automatically be applied within a few seconds to the Management 
Server. 

  
 
With this the update client will re-connect to the Management Server every 15 seconds to look for modified 
configuration or other updates. Be aware that you should not use an update interval this short within a 
productive environment! Recommended values start are not less than 1 hour (3600 seconds) depending on the 
requirements. 
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5.3.3. Defining updates for the clients 

This far our client will not yet receive anything from the Management Server in spite of being able to establish 
an update session and us having created a configuration for “user1@eap.md5” previously. So how can it be 
achieved that the configuration is actually transferred the client? 
The Management Server must be configured through a so-called “software update list” which information has 
to be provided to the clients. Software update lists are configured on group level and can be inherited by 
subgroups as already seen with the client templates. 
It depends on the requirements of the setup whether to have one update list for all or differentiate between 
groups. In this sample installation we will use one root group based update list serving the EAP-MD5 and the 
EAP-TLS group. 
To define an update list, go to the “Software Management” menu in the Management Console and select 
“Software update lists”. Then click “New” to create a new one. 

  
 
Enter a meaningful name for the update list (here: “My Update List”) and click the “Add” button to create a 
new package entry. A list of available packages will be presented in drop down list. Select “Client 
Configuration”. After that go to the “Info” tab and enable “Entry inherited to subgroups” to make this update 
list also available in the groups below root. Then click “OK” to save the new update list. 
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Now this new update list can be assigned to our client template. In the root group select the according client 
template (here: “SRX – IKEv2 with EAP”). Then in the “Configuration” tab select “General” and click on the 
“Software update list” which will show the available update list(s). 

 
 
Select your update list (here: My Update List) and save the configuration via the green tick in the icon bar. This 
will immediately enable this update list for all existing users under this template. 

5.3.4. Retrieve the update from Management Server 

Remember that the update client will only reach out for the Management Server after the 24-hour timer has 
run down. You could either wait or – properly the better option – just restart the update client. With 
administrator privileges restart the “NCP Client Update Service” (alternatively call “net stop rwsrsu” followed 
by “net start rwsrsu” in a command prompt run with administrator privileges). 
After that establish the client VPN connection and look at its log which should still be filtering on “update”. The 
log will start with the line of the update connect to the Management Server and after that the update info 
windows will pop up informing about the update packages being processed. 
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The “Remote Software Update” info window will automatically close after 5 seconds. The information displayed 
in this window depends on the assigned software update list. The “Log File Upload” is always shown no matter 
which packages have been added to the update list. As we only added the “Client Configuration” package to 
our list it is displayed here. Looking at the log file again you will see entries for the configuration download and 
that the update has finished. With the previously reduced “Check Interval” the update client will look for 
updates again in 15 seconds. 
There also is a dedicated update client log named “rwsrsu.log” written to the log folder in the client’s 
installation path. For the recent update session this log contains the following lines (among others): 
17-04-03 14:04:18 Start Update (VPN) 
17-04-03 14:04:18 Software Update: Connect to 10.10.10.1 
17-04-03 14:04:18 Request Logon (VpnUserID=user1@eap.md5, PcName=DESKTOP-JO4AL9J, fromCert=0) 
17-04-03 14:04:19 Request Package [RWSCFG] 
17-04-03 14:04:19   Downloading File C:\Program Files\NCP\Exclusive Remote Access 
Client\rsudata\RWSCFG\v_1_0\2\ncpphone.cnf 
17-04-03 14:04:19 Request Package RWSCFG ret = 0 new=1 
17-04-03 14:04:19 Copy ncpphone.cnf file (ok=1, err=0, C:\Program Files\NCP\Exclusive Remote Access 
Client\\rsudata/ncpphone.cnf->C:\Program Files\NCP\Exclusive Remote Access Client\/ncpphone.cnf) 
17-04-03 14:04:19 Software Update: Download new Configuration ok 
17-04-03 14:04:19 Disconnect 
17-04-03 14:04:19 Software Update: finished 
17-04-03 14:04:21 Software Update: update ok (VPN) --> next update in 15 sec 

The first highlighted line “Request Package [RWSCFG]” states that the “Client Configuration” package is part of 
the software update list and in phase there is verified whether there is a new configuration available on the 
Management Server. This is stated by the second highlighted line with the info “new=1”; meaning there is a 
new configuration available and has to be downloaded. 
Checking if there is a new configuration available on Management Server is done by comparing the 
“ncpphone.cnf” on the Management Server to the one existing on the client. The third highlighted entry above 
is “rsudata/ncpphone.cfg” which indicates that the “ncpphone.cnf” downloaded from the Management Server 
is not only copied to the regular installation path of the client but also to the “rsudata” folder in this path. The 
update client compares a “ncpphone.cnf” file in the client’s “rsudata” folder with the one available on 
Management Server. If there is no cnf-file in “rsudata” or the Management Server one is newer than the local 
one it will be download from Management Server. You can try this by keeping the VPN tunnel connected and 
deleting the “ncpphone.cnf” in the “rsudata” folder. With the next update session it will be downloaded again. 
Disconnecting the VPN connection will start the import process of the cnf-configuration into the 
“ncpphone.cfg” file as described earlier in this document. 
 
In the Management Console’s live log you should see repeated “RSU Login” lines showing the update sessions 
of the client. In the management console you can also verify if the client already downloaded the configuration 
by looking at “Info” tab on the respective client entry (here: user1@eap.md5). 

 
 
The entry for “last action” should be “Downloaded”. Whenever you change a client setting on Management 
Server and create the configuration for this client (or all in the group) it will be downloaded by the update client 
with the next session. Just play with it a little bit by changing the profile name in the template… 

  

mailto:user1@eap.md5
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5.4. Licensing 

Every NCP software product comes with a 30-day trial period. Within this time frame the product can be tested 
without limitations. Before the trial expires for Management Server and clients they should be equipped with 
valid licenses each. 

5.4.1. Subscription License 

If you have purchased a subscription license for NCP Exclusive Remote Access Management Clients this will 
include the number of Managed Units for Management according to the number of clients you licensed. The 
following licenses are available: 
 Desktop Clients 

A desktop client license can be used with these client flavors: 
 NCP Exclusive Remote Access Windows Client 
 NCP Exclusive Remote Access macOS Client 

 Mobile Clients 
A mobile client license can be used with these client flavors: 
 NCP Exclusive Remote Access iOS Client 
 NCP Exclusive Remote Access Android Client 

To provide the Exclusive Remote Access Management Console with your license go to the Edit menu and select 
Subscriptions. The information that no subscriptions have been found yet will be displayed. Click the Download 
button to proceed. 
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First you have to specify within which groups on the Management Server the license is going to be available. In 
a multi-tenant environment, it could well be that different licenses are assigned to different groups (=tenants). 
This example works with a flat structure and therefore the license is assigned to the root (“/”) group. 
The next step is to enter the license information which enables the Management Server to download the 
respective subscription details from the NCP Activation Server. Enter Subscription serial number, Download Key 
and a valid E-mail address. 
 

    
 
The Management Server will connect securely to the NCP Activation Server which verifies the validity of the 
subscription license and if successful will feed the Management Server with the respective subscription details. 
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After the successful verification and download the according information is displayed in the dialog. 

 
 
Click the Close button to leave the subscription download. 
 
Additionally, you can view the amount of licensed Managed units by selecting Info the Management Server 
menu: 
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5.4.2. Client license deployment 

Client licenses are solely handled by the Management Server and cannot be assigned locally on the client 
system. In the client GUI select “Licensing” from the “Help” menu to see how much trial days are still left. 

  
 
For an overview of the available client licenses coming with your subscription in the Management Console open 
the “Edit” menu and select “Activation Keys – Overview” and click “Import” in the following dialogue. 

  
 
However, the Management Server still requires configuration to deploy these licenses. The first step is to 
configure the root group to make licenses available to subgroup. Right click on the root group and select “Edit” 
in the context menu. This will open the “Group settings” window for the root group (“/”) where the option “Use 
license keys in subgroups” must be enabled. Save the changes with “OK”. 
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Last but not least the client template must be modified to process licenses. Select the according template and 
in the “Configuration” tab select the “Product” group. Enable the option “Automatic distribution of license 
keys” as highlighted below and save the changes using the green tick on the icon bar. 

 
 
The Management Console’s live log will immediately display “Tasks” related entries informing about the 
number of licenses having been distributed. As only one client object (“user1@eap.md5”) has been created so 
far the number here is “1”. 

 
 
Verify the assigned license by going to the client configuration and looking at the “Product” group in the 
“Configuration” tab. “Activation key”, “Serial number” and “Version” should be listed here. 
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It is not required to create the configuration for the user as the license part is handled outside the configuration 
between update client and Management Server. 
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5.4.3. Receiving license information on the client 

On the client open the “Logbook” again and extend the filter to “update license” which will show all log lines 
containing either the string “update” or “license”. Then establish the VPN connection to start the update 
session as already described before. After the tunnel is up the client log should soon show information about 
the software update and licensing as in following screenshot. The important line contains “Installed as a full 
license (managed by Management Server)”. 

 
 
Also take a look at “Licensing” in the client’s “Help” menu to verify the current licensing status of the client. 

 
 
The previously mentioned “rwsrsu.log” (written to the log folder in the client’s installation path) also shows the 
information of the recent update session (only specific lines listed below): 
17-04-03 16:44:45 Software Update: Connect to 10.10.10.1 
17-04-03 16:44:45 Reading license file 
17-04-03 16:44:45 Call rwscmd -> new license from Management Server 
17-04-03 16:44:46 Call ncpclientcmd -> check ncp.db 
17-04-03 16:44:46 Disconnect 
17-04-03 16:44:48 Software Update: update ok (VPN) --> next update in 15 sec 

 
The updated license is written to the “ncp.db” which holds the license status of the client. The client has to get 
in touch with the Management Server at least once every 16 days. Otherwise it will lose its status of full license 
and only allow for a VPN connection to communicate with the Management Server. Any other communication 
will be blocked until the license status can be updated. 
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Appendix 
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A Installation of supported database servers 

The NCP Exclusive Remote Management Server requires a separately installed database server and supports 
various of those, such as MariaDB, Microsoft SQL Server and others. This documentation describes how to 
install and setup MariaDB on Windows and Linux systems and furthermore Microsoft SQL Server 2014 Express. 
Please refer to the respective manuals of those database servers for more details regarding installation and 
operation if necessary. 

A.1. MariaDB 

When using MariaDB we strongly recommend to use the Connector/C interface in combination with the NCP 
Exclusive Remote Management Server. While the installation package for Linux usually already contains the 
required library a separate installation is required on Windows. 
This example is based on the MariaDB Server version 10.2.9 64-bit for Windows (mariadb-10.2.9-winx64.msi) in 
combination with the MariaDB Connector/C version 3.02 64-bit (mariadb-connector-c-3.0.2-win64.msi). 

A.1.1. Installing MariaDB Server on Windows 

Execute the MariaDB Server’s MSI package and use standard settings throughout the installation (with 
specifying an individual password for the root user).  

 
 
The installation includes the HeidiSQL tool to create databases, users etc. Start HeidiSQL to prepare the 
MariaDB Server for the NCP Exclusive Remote Access Management Server. 
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To connect to the database server (given it is installed on this system) enter the password for root user which had been defined 
during the MariaDB Server installation. 
 
 
 
 
After logon create a new database as shown below: 
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The new database should now be listed as shown in the screenshot below. 

 
 
The tables for this yet empty database will be automatically created by the installation of the NCP Exclusive 
Remote Access Management Server. 
To provide access to this database server the MariaDB Connector/C interface must be installed additionally. 
To do so execute the MSI package mariadb-connector-c-3.0.2-win64.msi and select the Typical setup without any 
special settings. 
 

 
 
This concludes the database setup and the NCP Exclusive Remote Access Management Server can be installed.  
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A.1.2. Installing MariaDB on CentOS Linux 

Preparation of CentOS 
You need to provide a basic installation of CentOS 7 with the necessary routing and access settings required for 
your specific environment. The installation of the NCP Exclusive Remote Access Management Server requires 
root privileges, so if you want to use an individual user, add the account to the sudoers. 
 

Providing a database with MariaDB 
Use yum to install the packages for MariaDB as shown below. 
sudo yum install mariadb-server 

 
When all the packages have been installed, you need to start the database system and enable access. 
sudo systemctl start mariadb 
sudo systemctl enable mariadb 

 
Create a database and a new user in MariaDB and all rights for the new user on the new database. 
sudo mysql -u root 

In the mysql client: 
create database mydatabase; 
create user 'mydbadmin' identified by 'mypassword'; 
grant all on mydatabase.* to 'mydbadmin'@'localhost' identified by 'mypassword' with grant option; 
exit 

 
This concludes the database setup and the NCP Exclusive Remote Access Management Server can be installed.  
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A.2. Microsoft SQL Server 2014 Express Installation 

This example is based on the following setup package of MS SQL Server 2014 Express with Tools, product 
version 12.0.2000.8: SQLEXPRWT_x64_ENU.exe 

The installation of the SQL Server requires .NET Framework 3.5 SP1 which cannot be installed if certain security 
updates have been applied. See the following link for further details: 
https://support.microsoft.com/en-us/kb/3005628 
 

Installing the SQL Server 
 SQL Server Installation Center - Installation 

Select “New SQL Server stand-alone installation or add feature to an existing installation” 
 SQL Server 2014 Setup  

 License Terms 
Check “I Accept the license terms”. and press “Next” 

 Microsoft Update 
Neglect the Microsoft Update part for now (to save time) and press “Next”. 

 Feature Selection 
Use defaults and press “Next”. 

 Instance Configuration 
Specify a decent “Instance ID” according to your likings then press ”Next”. 
(This example goes with the default “SQLEXPRESS”) 

 Server Configuration 
Specify the Administrator account for “Account Name” and enter the according password in the 
“Password” column, then press “Next”. 

 Database Engine Configuration 
Check “Mixed Mode (SQL Server authentication and Windows authentication)” and “Specify the 
password for the SQL Server system administrator (sa) account”. 
Leave all other options at default settings. Then press “Next”. 
(Installation progress will be shown for a while) 

Configuration of the SQL Server 
Start the “Microsoft SQL Server Management Studio” and connect using “Windows Authentication” which 
won't require any further credentials at this stage. 

 
  

https://support.microsoft.com/en-us/kb/3005628
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Create a new database for the Management Server 
 Select “Databases” in your SQL Server and right click “Databases” and select “New Database...” 

 
 Enter the desired “Database name” then press “OK” to create the new and empty database 
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Create a new user for the database 
 Goto “Security” and select “Logins” then right click “Logins” and select “New Login...” 

 
 “General”  

 
 Enter the desired “Login name” 
 Select “SQL Server authentication” 
 Enter the “Password” and “Confirm password” 
 Uncheck “Enforce password policy” if desired 
 Select your previously created database in “Default database” 
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 “Server Roles” 
Stick with defaults 

 “User Mapping” 

 
Check your previously created database in “Map” and check “db_owner” in “Database role membership” 
(here: “vSRX”) 

 “Securables” 
Stick with defaults 

 “Status” 
Stick with defaults 

 Confirm your entries with “OK” 
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A.2.1. Creating an ODBC data source for the Management Server 

 
Start “ODBC Data Sources (64-bit)” to create an ODBC connection. In the “ODBC Data Source 
Administrator (64-bit) move to the “System DSN” tab and click “Add…” for a new entry. In the following 
dialogue select “ODBC Driver 11 for SQL Server” and click “Finish”. 

  
 
In the window “Create a New Data Source to SQL Server” enter a meaningful “Name” (here: “vSRX”) and 
an optional “Description”. In “Server” enter the name of your SQL Server where the new database for 
your Management Server had been created previously, then click “Next”. 
Enter “Login ID” and “Password” as assigned to the database user earlier under the option “With SQL 
Server authentication using a login ID and password entered by the user.” Then click “Next”. 
 

  
 
Check the box “Change the default database to:” and enter/select the name of your Management Server 
database. Then uncheck both of the “ANSI” options and click “Next” to move to next page. 
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Stick with the given defaults and click “Finish” to complete the ODBC configuration. 

  
 
A summary of the settings will be displayed and the settings can be verified by clicking “Test Data 
Source…”. This should result in “TESTS COMPLETED SUCCESSFULLY!” as shown in second screenshot 
below. 

  
 
Database and ODBC source are now prepared so that the installation of NCP Secure Enterprise 
Management Server (Management Server) can be approached. Click “OK” to leave the ODBC data source 
configuration. 
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B Client Installation on Windows 

This chapter describes how to install the NCP Exclusive Remote Access Client on Windows operating system. 
Please also consult the NCP web site for further information about the client software. 
https://www.ncp-e.com/en/exclusive-remote-access-solution/vpn-client 
 
Open the folder with the installation package and execute it. 

 
 

 After having selected the installation language the “Install Wizard” will guide through the setup 

 
 

 Accept the license agreement and click “Next” 

 
 

https://www.ncp-e.com/en/exclusive-remote-access-solution/vpn-client
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 Specify the “Destination Folder” and set “Advanced Options” according to your needs 

  
 

 The wizard is ready to start the installation. Click “Install” to begin 

  
 

 If asked for permission by the UAC confirm with “Yes” to install the software 
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 This will take a while as setup will go through various stages... 

When setup has completed click “Finish” 

  
A restart of the system is required after the installation. 
 

After the reboot the client starts automatically and will ask you to start the 30-day trial period. 
Click “Yes” to start working with the client. 
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C SRX configuration sample 

The configuration listed below is a very basic one, simplified and exclusively focused on the VPN connections 
used in this scenario. Please visit the NCP website for further configuration guides. 
 (https://www.ncp-e.com/en/exclusive-remote-access-solution/documents-faq/) 

C.1. General configuration 

set interfaces ge-0/0/0 unit 0 family inet address 10.10.10.249/24 
set interfaces ge-0/0/2 unit 0 family inet address 192.168.100.249/24 
set interfaces st-0 unit 0 family inet address 172.16.119.254/24 
set interfaces st-0 unit 1 family inet address 172.16.119.253/24 
 
set security zones security-zone trust interfaces ge-0/0/0 
set security zones security-zone trust interfaces ge-0/0/2 
set security zones security-zone trust interfaces ge-0/0/0 host-inbound-traffic system-services all 
set security zones security-zone trust interfaces ge-0/0/2 host-inbound-traffic system-services all 
set security zones security-zone trust interfaces ge-0/0/0 host-inbound-traffic protocols all 
set security zones security-zone trust interfaces ge-0/0/2 host-inbound-traffic protocols all 
 
set security policies default-policy permit-all 
set security zones security-zone trust interfaces st0.0 host-inbound-traffic system-services all 
set security zones security-zone trust interfaces st0.0 host-inbound-traffic protocols all 
 
set security pki ca-profile NCP_CA ca-identity ncp.juniper.net 
set security pki ca-profile NCP_CA revocation-check disable 
set security pki ca-profile NCP_VMDEMO_CA ca-identity vmncp.demo 
set security pki ca-profile NCP_VMDEMO_CA revocation-check disable 
 
set security ike proposal IKEv2_EAP_PROP authentication-method rsa-signatures 
set security ike proposal IKEv2_EAP_PROP dh-group group19 
set security ike proposal IKEv2_EAP_PROP encryption-algorithm aes-256-gcm 
set security ike proposal IKEv2_EAP_PROP lifetime-seconds 10000 
 
set security ike policy IKEv2_MD5_POL proposals IKEv2_EAP_PROP 
set security ike policy IKEv2_MD5_POL certificate local-certificate NCP_CA 
set security ike policy IKEv2_TLS_POL proposals IKEv2_EAP_PROP 
set security ike policy IKEv2_TLS_POL certificate local-certificate NCP_VMDEMO_CA 
 
set security ike gateway IKEv2_MD5_GW ike-policy IKEv2_MD5_POL 
set security ike gateway IKEv2_MD5_GW dynamic hostname eap.md5 
set security ike gateway IKEv2_MD5_GW dynamic user-at-hostname @eap.md5 
set security ike gateway IKEv2_MD5_GW dynamic connections-limit 100 
set security ike gateway IKEv2_MD5_GW dynamic ike-user-type group-ike-id 
set security ike gateway IKEv2_MD5_GW local-identity distinguished-name 
set security ike gateway IKEv2_MD5_GW external-interface ge-0/0/2.0 
set security ike gateway IKEv2_MD5_GW aaa access-profile IKEv2_EAP_RAD 
set security ike gateway IKEv2_MD5_GW version v2-only 
 
set security ike gateway IKEv2_TLS_GW ike-policy IKEv2_TLS_POL 
set security ike gateway IKEv2_TLS_GW dynamic hostname eap.tls 
set security ike gateway IKEv2_TLS_GW dynamic user-at-hostname @eap.tls 
set security ike gateway IKEv2_TLS_GW dynamic connections-limit 100 
set security ike gateway IKEv2_TLS_GW dynamic ike-user-type group-ike-id 
set security ike gateway IKEv2_TLS_GW local-identity distinguished-name 
set security ike gateway IKEv2_TLS_GW external-interface ge-0/0/2.0 

https://www.ncp-e.com/en/exclusive-remote-access-solution/documents-faq/
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set security ike gateway IKEv2_TLS_GW aaa access-profile IKEv2_EAP_RAD 
set security ike gateway IKEv2_TLS_GW version v2-only 
 
set security ipsec proposal IPSEC_PROP protocol esp 
set security ipsec proposal IPSEC_PROP encryption-algorithm aes-256-gcm 
set security ipsec proposal IPSEC_PROP lifetime-seconds 3600 
set security ipsec policy IPSEC_POL perfect-forward-secrecy keys group19 
set security ipsec policy IPSEC_POL proposals IPSEC_PROP 
 
set security ipsec vpn IKEv2_MD5_VPN bind-interface st0.0 
set security ipsec vpn IKEv2_MD5_VPN ike gateway IKEv2_MD5_GW 
set security ipsec vpn IKEv2_MD5_VPN ike ipsec-policy IPSEC_POL 
set security ipsec vpn IKEv2_MD5_VPN traffic-selector TS1 local-ip 0.0.0.0/0 
set security ipsec vpn IKEv2_MD5_VPN traffic-selector TS1 remote-ip 0.0.0.0/0 
 
set security ipsec vpn IKEv2_TLS_VPN bind-interface st0.0 
set security ipsec vpn IKEv2_TLS_VPN ike gateway IKEv2_TLS_GW 
set security ipsec vpn IKEv2_TLS_VPN ike ipsec-policy IPSEC_POL 
set security ipsec vpn IKEv2_TLS_VPN traffic-selector TS1 local-ip 0.0.0.0/0 
set security ipsec vpn IKEv2_TLS_VPN traffic-selector TS1 remote-ip 0.0.0.0/0 
 
set access profile IKEv2_EAP_RAD authentication-order radius 
set access profile IKEv2_EAP_RAD radius-server 10.10.10.250 port 1812 
set access profile IKEv2_EAP_RAD address-assignment pool IKEv2_EAP_POOL 
set access profile IKEv2_EAP_RAD radius-server 10.10.10.250 secret "mysecret" 
 
set access address-assignment pool IKEv2_EAP_POOL family inet network 172.16.119.0/24 
set access address-assignment pool IKEv2_EAP_POOL family inet xauth-attributes primary-dns 172.16.119.254/32 
set access address-assignment pool IKEv2_EAP_POOL family inet xauth-attributes primary-wins 172.16.119.254/32 
 
set security ike gateway IKEv2_MD5_GW tcp-encap-profile NCP 
set security tcp-encap profile NCP 

C.2. Certificate upload 

request security pki local-certificate load filename vsrx.pem key vsrx.key certificate-id NCP_VMDEMO_CA 
request security pki ca-certificate load ca-profile NCP_VMDEMO_CA filename vm-ncp2008en.crt 


